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Importancia del trabajo

La distribucion espacial y temporal de las precipitaciones a escala regional es necesaria para una variedad de usos
cientificos y aplicaciones sociales tales como estudios y diagndsticos climaticos, gestion del agua para la agricultura y
la energfa, mitigacion de sequia, control de inundaciones, y pronostico de los cultivos y eventos extremos. Un aspecto
muy comuin de monitoreo hidrolégico en los paises en desarrollo es la baja densidad de las redes de pluviométricas.
En situaciones ctiticas como las sequias y los petiodos de inundaciones, la falta de datos afiade un desafio adicional a
las instituciones encargadas de de mitigar y controlar los dafios y petjuicios, y produce una disminucién de la eficacia
de las medidas tomadas. En situaciones normales, la disponibilidad de informacién hidrolégica puede ayudar a
mejorar la productividad de la tierra, ya que permite una mejor gestiéon del mercado y las actividades productivas. Por
ello, el disponer de informacién hidrolégica se cuenta como un activo valioso, pero la tarea de cuantificar la
distribucién de las lluvias se complica por el hecho de que en la actualidad no hay un método de estimacién de la
precipitacién con la cobertura y la precision necesarias.

Nuestra propuesta es desatrollar una aplicacién capaz de utilizar los recursos provenientes del sistema de
diseminacién de DevCoCast, o cualquier alternativa satelital, asociada con datos de una red pluviométrica para
construir un producto mixto que estime precipitacién con bajo sesgo.

La estimacién de precipitacion diaria, utilizando un algoritmo que permita incorporar informacién de satélites y de
redes pluviométricas implica dos pasos cruciales: en primer lugar, la definicién de un algoritmo para estimar la
precipitacién a partir de un satélite; y en segundo lugar, definir y disefiar una técnica de fusién para incorporar la
informacién pluviométrica. En el primer caso, se utiliza el algoritmo “Hydroestimator” (Vicente et al., 1998) sobre el
satélite GOES como base para la recuperaciéon de las precipitaciones. Este producto se encuentra disponible bajo las
siglas “RFS” (Rainfall Satellite) dentro del flujo de datos del sistema GEONETCast. La segunda cuestién ha sido
ampliamente tratada en varios articulos en los ultimos afios, y la creencia general es que las observaciones
pluviométricas tienen un menor sesgo. Por lo tanto, esta prevalecera sobtre cualquier estimacion satelital en aquellas
regiones con una densa red pluviométrica, mientras que en las dreas sin datos terrenos o los grandes cuerpos de agua

las estimaciones satelitales van a tener un peso mayor en el producto final.

Obijetivos de la aplicacion

Los objetivos de la aplicacién aqui propuesta son:
1. Desarrollar un producto, mapa de precipitacién diaria, basado en la combinacién de una estimacion satelital
y datos de una red pluviométrica a través de la técnica CoSch (Combined Scheme technique, Vila et al.,
2009);
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2. Establecer un método para calcular estadisticas sobre las precipitaciones ocurridas en cualquier region de
interés (RO, por las siglas de Region of Interest) propuesta por los usuarios. Esto incluye el calculo de:
precipitaciéon media areal por cuenca, precipitaciéon maxima del dia, drea con precipitaciones > Imm, y
precipitaciéon media areal considerando solo las areas con mas de 1mm;

3. Proveer a los usuarios del sistema GEONETCast de una funcién automatica para procesar y obtener
productos diarios a partir de la informacion en tiempo casi-real. Los productos que se esperan generar son:
Precipitacion diaria estimada a partir de las imagenes RES de 15 minutos y Estimacién de la precipitacion
diaria corregida por el método de CoSch.

Esta aplicacion puede ser utilizada en formato manual, batch (procesamiento por lotes) o en forma automatica. La
aplicaciéon manual del procedimiento, paso a paso, es la mejor manera de entender cémo funciona el método
seleccionado, por ello, en este capitulo se explicard para un dia en particular en toda su extension. Este mismo
procedimiento puede usarse en el modo batch para procesar setries temporales de imagenes de cualquier longitud.
Para los usuarios del sistema GEONETCast el modo automatico puede utilizarse para obtener resultados diatios

directamente del flujo continuo de datos del satélite.

Datos utilizados

Limite Geografico y temporal de la aplicacion

El desarrollo practico de esta aplicacién sera llevado adelante dentro de los limites geograficos del producto RFS
distribuido por el INPE dentro del sistema DevCoCast. Para realizar el ejercicio se provee de una ROI constituida
por las principales cuencas hidrolégicas de America del Sur. Como fuente de datos pluviométricos se utilizé un set de
datos diatios, gratuitos y disponibles libremente pata todo el mundo, lo cual facilita la aplicacién de este ejetcicio a
otras dreas geograficas y determina una resolucion temporal diaria. Sin embatgo, cabe aclarar que esta aplicacion y la
metodologia CoSch (Vila et al., 2009) pueden ser adaptadas a cualquier: ROI, producto de estimacion satelital de la

precipitacién, ubicacién y resolucion temporal.

Datos locales y/o regionales (terrenos)

Los datos locales o mediciones que son necesarios para esta aplicacion son los datos pluviométricos. La metodologfa
CoSch para estimar la distribucién de la precipitacién nos permite aumentar la eficiencia al incorporar informacion
de distintas fuentes (satelitales y terrestres). Para este ejercicio la informacion pluviométrica es obtenida del NOAA’s
Climate Prediction Centre Unified Gauge-Based Analysis of Global Daily Precipitation. Este set de datos tiene entre
sus ventajas la libre y gratuita accesibilidad a través de su portal:

ftp://ftp.cpc.ncep.noaa.gov/precip/CPC UNI PRCP/GAUGE GLB/.

Este set de datos tiene una cobertura global a una resolucién espacial de 0.5 grados, y contiene informacién desde el

1 de Enero de 1979 hasta el presente. Si bien la informacién es llevada a un mapa interpolado de todo el globo, este
esta basado en informacién proveniente de 30.000 pluviémetros en la version retrospectiva (1979-2005) y 17.000
para la versiéon en tiempo real (2006 hasta el presente). Para cada dia se encuentran disponibles 2 imdigenes
georreferenciadas: 1.- Precipitacion diaria por pixel, 2.- Numeros de estaciones pluviométricas con datos dentro de
cada pixel. Dado que un pixel puede contener mas de un pluviémetro o ninguno, cada pixel tendra un valor medio o
interpolado que represente su comportamiento en funcién del de sus vecinos. Para la ejecucion de este ejercicio los
pixeles que no contienen pluviémetros seran removidos del analisis. Esto se debe a que su valor no esta basado en
una observacion y por lo tanto no puede ser considerado para la correccion del sesgo de una estimacion satelital.

Otro dato local que debe ser provisto por el usuario es el area de interés sobre la cual calcular las estadisticas de

precipitacién. En nuestro ejercicio estos son las cuencas mas representativas de América del Sur.

Datos del sistema GEONETCast — DevCoCast (satelitales)

Los datos usados en esta aplicacién son parte del flujo de DevCoCast America. El producto es enviado por el
CPTEC - INPE y publicado bajo el nombre “Rainfall Satellite - RFS”. Los datos son una imagen en formato

GEOTIFF, de un tamafio aproximado de 200KB,con una resolucién temporal de 15 minutos y una resolucion



espacial de pixel de 4km. Basicamente, el RES es el resultado de la aplicacién y adaptacion de una version mejorada

del algoritmo “Hydroestimatot” para transformar los canales térmicos del satélite GOES East en precipitacion.

Metodologia

El esquema propuesto, Combined Scheme (CoSch), combina en un solo método dos enfoques distintos para reducir
el sesgo de estimacion satelitales. De esta forma, este método supera las limitaciones que cada enfoque tiene por
separado y permite producir mapas de precipitacién con campos continuos. En la Figura 11.1 se representa el

diagrama de flujo de este procedimiento.
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Figura 11.1 Procedimiento metodologico de esta aplicacion

La correccion aditiva del sesgo (ADD) se define de la siguiente manera:

ADD = rr_sat + (rr_obs —rr_sat) Eq.1
Donde tr_sat es el valor estimado por el satélite y el segundo termino representa el sesgo aditivo medio local para un
grupo de pixeles entre la precipitacion observada (rr_obs, CPC en este caso) y estimada por el satélite (RES, en este

caso).

La correccion proporcional (ratio) del sesgo (RAT) se define como:



rr_obs

rr_sat Fq.2

RAT =rr_satx

Donde aplica la misma convencién que en el caso de correcciéon aditiva.

Cuando no hay informacién pluviométrica, se mantiene el dato estimado por mediante satélites. Pero para las zonas
de influencia de los pluviémetros se analiza la diferencia entre las correcciones de sesgos ADD y RAT. Un enfoque
particular es utilizado para realizar la correccién en esa area de influencia basada en la menor diferencia entre lo
observado y lo estimado por cada enfoque.

Una vez obtenido un mapa de precipitaciones diarias basado en la combinacién mas parsimoniosa de los datos de

entrada, se realizan los analisis estadisticos patra nuestras regiones de interés (ROI) y se exportan a una tabla.

Analisis de datos

Pre-procesamiento de los datos de entrada

Antes de empezar con el analisis hay que realizar algunos pre-procesos para preparar las 3 imagenes raster que
necesitamos en la metodologfa propuesta (RFS, CPC and ROIs). Hay que asegurar que todas las imagenes tengan los
mismos limites geograficos y la misma resolucién. En nuestro caso el objetivo es llevar todo al limite geografico del
producto RFS, pero vamos a elegir una resolucion intermedia entre los productos (RFS 4km, CPC 0.5 grados) de
0.25 grados.

Para facilitar el ejercicio la imagen de las areas de interés (ROI) ya se encuentra provista en el sistema de coordenadas
y la resolucién adecuada. Esta imagen de ILWIS no es otra cosa que un “class map” donde cada categotia representa
a una cuenca hidrolégica.

Las imagenes de RES son descargadas por los usuarios a razén de 1 cada 15 min., por lo que necesitan ser integradas
en una imagen diaria. Un punto importante para considerar en este paso es la hora de inicio/fin de la integracion
diaria, dado que este debe ser el mismo tanto para la estimacion satelital como para la pluviométrica. En nuestro
ejemplo, para América del Sur, el periodo de integracion diaria de hoy empezaria a correr desde ayer a las 12:15 hrs
UTC hasta hoy a las 12:00 hrs UTC. Las unidades del producto RFS son mm/h y el procedimiento para su
integracion diaria es: calcular la media para todas las imdgenes obtenidas en el dia y multiplicatla por 24. De esta
manera se pueden disttibuir los errores debidos a la falta de imagenes, algo que es muy comun en esta clase de
productos con resolucion de 15min. Para realizar la integracion se puede establecer un procedimiento automatico
sobre el flujo en tiempo real del satélite, o se pueden aplicar procesamientos por lotes en series de datos archivados.

En este ejercicio ya se provee una imagen RFS diaria del dia 3 de enero de 2011, llamada “hydro_20110703".

Manos a la obra:

Descomprima y copie los datos del ejetcicio en un directorio de trabajo, inicie ILWIS y usando su navegador abra el
directotio de trabajo. Reinicie ILWIS (Cerrar y abrir el programa) para que este se convierta en su nuevo directorio
activo. En el catalogo de la ventana principal de ILWIS deberfa observar un mapa con el nombre “hydro_20110103”.
Haga doble click sobre el nombre para abritlo y use como Representation la opcion “mpe_suni’ y presione “OK”.
Explore la imagen con el botén izquierdo apretado, observe los valores e inspeccione el sistema de coordenadas
usado en la representaciéon. Haga doble click en el botén “Properties” que se encuentra en la ventana de leyenda a la
izquierda de la imagen. Agregue una capa con los limites de los paises llamada “country_02”, use las opciones “Info off”
y “Boundaries Only”. Notara que la patte sur de Chile y Argentina no contienen datos, esto se debe a que este producto
solo permite estimar precipitacién hasta los 45 grados de latitud Sur.

El proximo paso es el de cambiat la resolucion de esta imagen (4km) a la resolucion de 0.25 grados que es nuestro
objetivo para el producto final. Esto se realiza utilizando la opcién “Resample’ que se encuentra en el ment principal
de ILWIS dentro de: “Operations” > “Spatial Reference Operations” > “Raster’. Los atributos a emplearse en esta



operacién de Resample se puede observar en la figura 11.2 (izquierda) y el resultado esperado debe ser como el de la

figura 11.2 (derecha). Realice usted la operacién y contraste los resultados.
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Figura 11.2 Resample de Ia imagen RFS. Atributos y resultados.

Los datos del CPC pueden ser descargados via ftp (ver la direcciéon mads arriba) y las imagenes deben ser pre-

procesadas para llegar a la misma resolucién de pixel y limites geograficos que la imagen RFS creada recientemente

(hydroestimator_025). Las imagenes del CPC tienen una resolucion espacial de 0.5 grados y una cobertura global, para

este ejercicio solo nos interesa la region de Sudamérica con una resolucién de 0.25 grados. Si usted tiene conexién a

internet en este momento, puede ir al sito ftp del CPC y descargar los datos correspondientes al dia de este ejercicio.

En la carpeta RT (Real-Time, tiempo real es el producto a partir del 2006) usted deberfa encontrar el archivo:
“PRCP_CU_GAUGE_V1.0GLB_0.50deg./lnx. 2071107103.RT”. En caso de no tener conexién a internet hay una copia

de este archivo en su catpeta de trabajo.

El procedimiento necesario para importar esta imagen a un GIS requiere que observemos cuidadosamente los

metadatos tipos del CPC:

El formato del archivo es Binatio, real (float) y sus valores estan codificados en little Endian byte order (no
‘swap’) donde undefine/sin datos es igual a -999.0;

header size = 0, lo datos estan almacenados con una secuencia de bandas acorde a una estructura de archivo
BSQ;

Numero de Filas / Columnas = 360 / 720;

Sistema de coordenadas geograficas Lat/TLong WGS84 con latitud minima / méxima de las esquinas -90 /
90; Longitud minima / maxima de las esquinas 0 / 360;

Numero de bandas = 2: Rain = Precipitacion (prcp) = producto del andlisis de interpolacién pluviométrica

(0.1mm/dia); y Gnum = Nuamero de estaciones pluviométricas consideradas en el pixel (gauges).

Si bien en la versiéon mas actual de ILWIS se pueden incluir muchas mds opciones en la linea de comando para

importar un archivo raster genérico, por el momento introduzca en siguiente comando pata importar ambas capas de

del producto de CPC:

cpc_temp:=maplist(prcp_cu_gauge_v1.0glb_0.50deg.Inx.20110103.rt,genras,Convert,720,2,0,BSQ,Real 4,
NoSwap,CreateMpr)



Una vez realizada la importacién se crea un “maplist” de ILWIS, si usted abre el maplist “cpc_temp” vera que esta
formado por 2 archivos o bandas. Ahora abra la banda “gc_temp1”, utilizando como Representation la paleta

“Psendo”, esta operacién deberia mostrarles un mapa como el de la figura 11.3.
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Figura 11.3 Capa de precipitacion resultante de Ia importacion del CPC gauge data

Las capas del CPC estan escritas para ser leidas de Oeste a Este y de Sur a Norte, pero la mayoria de los paquetes de
software modernos utilizan el método estandar de lectura Norte — Sur. Haga click con el botén derecho del mouse
sobre el nombre de la capa abierta recientemente “gpe_temp1”, en el mend contextual que se despliega seleccione la
opcion “Spatial Reference Operations” > “Raster” > “Mirror Rotate”, elija la forma “Mirror Horizontal” y especifique el
nombre de salida como “epc_temp1_mirror’. Usted deberia obtener un mapa como el de la figura 11.4.
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Figura 11.4 Capa de precipitacion resultante de Ia operacion Mirror Rotate - Mirror Horizontal

Algo importante que debe notar es que las capas que hemos abierto del CPC no poseen un sistema de coordenadas
asociadas “No Coordinates”. 'También note lo raro que es observar el mapa mundial con los continentes en esta
posicion.

Antes de encarganos de la geo-referenciacion repita el procedimiento de rotacién para la banda 2: “ope_temp2” y
observe como se distribuyen las estaciones en el mundo. Para visualizar el mapa utilice la paleta “Inverse” realizando
un strech de “0” a “1”.

Si usted desea explorar otro método para la realizar la operacién deseada puede revisar cual fue la linea de comando
que uso ILWIS al ejecutar del mend contextual la operacion anterior, y luego pude modificarla para hacer un nuevo
comando:

cpc_temp2_mirror.mpr:=MapMirrorRotate(cpc_temp2,MirrHor)
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Figura 11.5 Capa de Estaciones pluviométricas después de ejecutar Mirror Rotate - Mirror Horizontal

Ahora nos encargaremos de geo-referenciar estos 2 mapas, lo cual representa un desafio extra ya que el sistema de
coordenadas global que se usa normalmente esta preparado para encontrar el continente americano a la izquierda
(Oeste) y Europa-Africa a la derecha (Este). Si bien solo necesitamos Sudamérica para este ejercicio, vamos a
aprender a geo-referenciar todo el globo. El método para hacer esto es de una manera mas facil es: Cortar las bandas
en hemisferio Este y hemisferio Oeste e invertir el orden actual.

Seleccione la opcion “Sub Map” del menu “Operations” > “Spatial Reference Operations” > “Raster’. Para cortar los
hemisferios de las bandas de precipitacion (templ) y de estaciones pluviométricas (temp2), primero lea y luego utilice

las especificaciones que se indican en las imagenes siguientes (figura 11.6)
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Figura 11.6 Creacion de sub-mapas con los hemisferios Este y Oeste

Corrobore que los sub-mapas resultantes estén correctos. Note que hay algo muy extrafio en Australia, si es que no
lo ha notado antes: una porcién del pafs parece haber desaparecido, ello se debe a que por las intensas inundaciones
de ese momento no se contaron con datos para esa zona. Siempre corrobore detalladamente el resultado de cada
operacién que haga. Una inspeccién visual en su momento puede ahorrarle mucho tiempo, prevenir problemas y
conclusiones erréneas!! En este caso, la falta de datos en Australia no afecta nuestro resultado ya que no pertenece a

nuestra area de estudio.



Para nuestro préximo paso, el juntar ambos hemisferios en el orden estandar, vamos primero a geo-referenciar cada
hemisferio por separado y luego usat la opcion de concatenar por coordenadas con el fin de lograr que el meridiano
de Greenwich quede en el centro de nuestro mapa. El primer paso de nuestro plan requiere que creemos 1 sistema
de coordenadas patra cada hemisferio, para ello selecciones del menu de ILWIS la opcién: “Create” > “GeoReference” y

creé dos geo-referencias llamadas “eas?” y “west”, vea los detalles en la figura 11.7.
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Figura 11.7 Detalle de las geo-referencias para los hemisferios Este (East) y Oeste (West)

Ahora que creamos las geo-referencias de cada hemisferio tenemos que asignarselas a las imagenes correspondientes.
Utilice el click derecho sobre el archivo “epe_temp1_eas?’, y en el menu contextual seleccione la opcion “Properties”. En
la ventana de propiedades seleccione la pestafia “Dependency” y luego presione el botoén “Break Dependency Link” y
presione “Yes” en la ventana de confirmaciéon. Abra nuevamente la ventana de propiedades de “ope_templ_east” y
ahora en “Georeference” seleccione la geo-referencia “east” y presione “OK”. Para ver si hemos logrado un resultado
adecuado, habra la imagen y superponga la imagen vectorial que contiene los limites administrativos de pafses,
“country_027, utilizando para la visualizacion las opciones “Info” off y “Boundaries Only”. Compruebe los resultados, y
preste especial atencion a la informacién de coordenadas que se encuentran en la parte inferior derecha de la ventana
de visualizacion.

Ahora repita este procedimiento para el hemisferio Oeste utilizando el mapa “¢pe_temp1_west”. Luego de que usted
haya logrado asignar la geo-referenciacién y haya comprobado que coincide de manera correcta con los limites
administrativos de los paises, es momento de pegar ambos mapas para lograr uno que contenga todo el globo. En el
menu principal de ILWIS seleccione la opcion “Operations” > “Raster Operations” > “Glue Maps”. Como 1t y 24> mapa
utilice “ope_templ_east’ y “cpc_temp1_west’ respectivamente, y como geo-referencia elija “full_WE”; como nombre de

salida (Output Raster Map) introduzca “prgp_20710703”. Sus resultados deberfan aproximarse a los de la figura 11.8.
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Figura 11.8 Mapa Final mostrando los campos de precipitacion interpolados por el CPC.

Gracias a estas operaciones ya tenemos un mapa global, y en el formato tradicional, de los campos de precipitacion.
La siguiente tarea que debe realizar es el mapa global de las estaciones con datos para ese dia. Para ello debera repetir
los pasos antetiores sobre la imagen “gpc_temp2_mirror”. Como nombre de salida de la ultima operacién (Glue Maps)

utilice “gauges 207710703”. Acuerdese de que para obtener una buena visualizacién de los datos de este mapa debe

utilizar la representacion “Inverse” y un stretch entre “0” y “17.

Ahora que tenemos ambos mapas en su cobertura global y su resolucién original, tenemos que recortar el area y la
resolucién necesarias para nuestro estudio. Este tltimo paso del pre-proceso requiere que usted haga un “resample” de
los mapas “prep_20110103” 'y “ganges_20110703” para que tengan las mismas caracteristicas de nuestro
“hydro_20110703” (0.25 grados de resolucién). Para hacer esto, recuerde lo utilizado en la figura 11.2 (izq) y llame los

mapas resultantes “prep_20110103_0257y “ganges_20110103_025” respectivamente.

En la figura 11.9 se muestran los resultados de esta operacion. Note ademas, que en el mapa de precipitacion las

zonas de océano han sido clasificadas como

cyr»

¢Puede usted también hacerlo?

i gauges_20110103_025: MapResample{gauges_20110103.mpr,5uda;
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Figura 11.9 Mapas finales de estaciones y precipitacion del CPC para nuestra drea y resolucion de estudio.

El pre-procesamiento ha terminadoll! Si usted observa el diagrama de flujo de la figura 1, notard que nos

encontramos en el principio del proceso y que ya tenemos todo lo necesatio para empezar!




Seguramente Usted ya ha notado que los valores del mapa “prgp_20717107103_025” son bastante elevados para la
precipitacion, esto se debe a que el valor original se ha multiplicado por 10. Este es un procedimiento habitual en
productos de diseminaciéon ya que permite guardar en un atchivo el valor real 12,6 en un formato entero como 126 y
de esta manera achicar considerablemente el tamafio de grandes bases de datos (al menos con los recursos
informaticos y de comunicacion de hace unos afios atrds, todo esto era muy importante y necesario). Mas adelante en

el ejercicio nos encargaremos de volvera convertir la informacién a su valor real original.

Antes de empezar con la nueva serie de calculos vamos a explicar mejor el procedimiento y nuestros objetivos. Los
coémputos necesarios no se realizaran paso por paso, usando la interface grafica, sino que utilizaremos un Script de
ILWIS. Un diagrama grafico del procedimiento se observa en la figura 11.10 y su subsecuente explicacion. Las

formulas para calcular los sesgos estan dadas en las ecuaciones 1 y 2.

% Add_hyd Rat_hyd
I ISR Mean bias bl |b1| |[b2 |b2
el
* bl y [ X x| x| x| x bl [bl | [b2 b2
o ! X112 X | x| x| x
= d < x| x| x Keep <
X ra
el X | x| x|x bl |b2
a y1v f
c bl |bl

Figura 11.10 Método para seleccionar el menor sesgo

Para empezar, solo utilizaremos aquellos pixeles que contengan al menos una estacién de medicién de
precipitaciéon para ese dia (a). Recordemos que los mapas del CPC han sido llevados de una resolucién de 0.5
grados a 0.25 grados, lo que produce una divisiéon del pixel (b). El hidroestimador por su lado, ha sido llevado a una
resolucion de 0.25 grados (c) por agregacion. Se calculan las iméagenes de los 2 sesgos (aditivo y proporcional) para
las celdas de 0.25 grados (d) y se aplica un filtro para obtener el sesgo medio para ambos casos (el cual puede
extrapolarse a un pixel vecino para aumentar el tamafio de la correccién) (e). Estos mapas de sesgo medio son los
utilizados en la correccion y se producen mapas del hidroestimador corregidos por ambos métodos (Add y Rat). Un
esquema en particular (aditivo o proporcional) serd seleccionado para cada pixel, el criterio es la menor diferencia
entre el hidroestimador cortegido y la obsetvacion terrena (cpc_precipitation) (f). Aquellos pixeles que estén en
zonas donde no hay estaciones no seran afectados por el método y se retendra el valor original del hidroestimador.

Calculo del sesgo

Para realizar todos los cémputos descriptos en los entre los puntos 1 y 4 del diagrama de flujo, le proponemos
utilizar un script de ILWIS llamado “bias” que se encuentra en su carpeta de trabajo. Seleccione el script “bias” del
catalogo de archivos y dbralo. Inspeccione su contenido e intérprete que tipo de operaciones se realizaran en cada
linea de comando, en el mismo texto encontrara lineas con explicaciones adicionales para entender algunos procesos.
Para ejecutar el script, presione el icono de “Run Seripf” ® y en la ventana emergente de paramettizacién introduzca

los mapas apropiados. El la figura 11.11 puede encontrara el ejemplo y luego presione OK para ejecutar.

Lﬁ; Script "ben_bias" x|

RFS rainfell | ERhyciroestimator_025 =

CPCgauges |Egeuges 20110103 025 |
CPC rainfall

Ok ICanceIl Help |

Figura 11.11 Parimetros necesarios para ejecutar el script “bias”




Luego de finalizado los cémputos abra el mapa hidroestimador corregido por el sesgo aditivo, llamado “hydro_add”,

utilice como opcioén de visualizacion “mpe_sun/’. En la ventana de visualizacion seleccione la opcién “File” > “Open

Pixcel Information” y de la ventana de Pixel Information seleccione las opciones “File” > “Add Map” y agregue todos

los mapas que han sido calculados para obtener el hidroestimador corregido por Add:

Mapas de Entrada: hydroestimator_025, gauges_20110103_025, prcp_20110103_025;
Mapas originales del CPC: prep_temp, gauge_boolean, prep_masked;

Mapas de sesgo: bias_add_temp, bias_add_for_sum, bias_add_for_count;

Resultados del filtrado: add_sum and add_count;

Sesgo medio: average_add and bias_add.

Mueva el cursor con el mouse sobre el mapa “bydro_add’ y observe los valores de los mapas intermedios. Esto le

permitira auditor los computos y a mejorar su entendimiento de las operaciones realizadas por los comandos del

script. Eventualmente pude usar la calculadora y comprobarlos manualmente. Sus resultados deberfan ser similares a
los de la figura 11.12.
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Figura 11.12 Mapas de sesgo medio (add y rat) e hidroestimadores corregidos por ambos sesgos

(hydro_add and hydro_rat maps)



Hemos observado que durante el procesamiento se incrementa el tamafio del area afectada con un determinado
sesgo, es decir que pixel original de una estacion tenfa 0.5 grados y fue transformado en 4 pixeles de 0,25 grados, para
luego agregar un pixel extra y producir un area de 0.75 grados. Usted puede usar la transparencia para poder
visualizar los mapas “bias_add’ y “bias_add_temp” en la misma ventana y de esta manera observar el efecto de este
filtro adicional (ver figura 11.13). Con la resolucién de trabajo (0.25), este incremento es el menor incremento posible
que uno puede realizar del drea de influencia de la estacion terrena. Razonemos que un area mayor, significa mayor
continuidad de los campos de precipitaciones, un efecto muchas veces buscado en la visualizacién de datos a gran
escala, pero que depende del fenémeno estudiado. Ahora bien, en busqueda de equilibrio, consideremos que tomar
una medicién de un fenémeno como la lluvia utilizando un 4rea de muestreo de 30 cm de diametro y luego distribuir

ese valor como referencia de un area de 50 km de radio (aprox. 0.5 grados) es ya, un gran salto de fe.
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Figure 11.13 Expansion del drea de influencia de las estaciones pluviométricas.

Proceso de decision y célculo del CoSch

Ahora es el momento de determinar cual método de correccion del hidroestimador presenta el menor sesgo o
diferencia con respecto a las mediciones terrestres, es decir a nosotros nos interesa saber cual de las correcciones
hace que el hidroestimador se acerque mas al valor medido. Esta diferencia puede ser tanto positiva como negativa,
pero de cualquier manera queremos la menor. Para esto vamos a utilizar la funcién “abs” de ILWIS que nos devuelve

el valor absoluto de una imagen u operacion.

El mapa de precipitacién que debemos usar en el proceso de comparacion es “prep_masked’, ya que es el que contiene
solo los pixeles que tienen datos basados en una observacion real (2x2 pixeles) y todo lo interpolado es eliminado.
Pero si recuerdan bien, en el proceso anterior utilizamos un filtro para incrementar el area de correccioén en 1 pixel

(3x3 pixeles). En este momento usted puede decidir con que tamafio de correccién desea continuar el calculo del

CoSch final.

Si usted decide que prefiere no utilizar datos interpolados hasta los 0.75 grados, y quiere conservar la resolucion de la

informacién original del CPC (0.50 grados), escriba las siguientes expresiones en la linea de comandos de ILWIS:

diff_abs_add:=abs(prcp_masked-hydro_add)
diff_abs_rat:=abs(prcp_masked-hydro_rat)

Si usted prefiere mantener el filtro de 3x3 para ganar un poco mas de continuidad en su mapa final utilize los

siguientes comandos:

gauge_temp_mask:=MapFilter(gauge_boolean,RankOrder(3,3,9),value)
prep_masked_big:=gauge_temp_mask * (prcp_temp/10)

diff_abs_add_big:=abs(prcp_masked_big-hydro_add)



diff_abs_rat_big:=abs(prcp_masked_big-hydro_rat)

Visualice los mapas resultantes y explore los valores de los pixeles para comprender su rango. Ahora tenemos las
diferencias absolutas entre ambas correcciones y el obsetvado, por lo tanto podemos seleccionar la correccion que

esta mas cercana al valor medido. Abajo se muestra un ejemplo utilizando los valores sin filtrar:
cosch_temp:=iff(diff_abs_add ge diff_abs_rat,abs(hydro_rat),abs(hydro_add))

Si usted eligié mantener el filtro de 3x3 o si estd haciendo ambos para comparar resultados (lo que indica ademas que
es un curioso y un buen estudiante), repita el procedimiento con los nombres correspondientes y llame al resultado

“cosch_temp_big”. Visualice los mapas utilizando como paleta de representacion “mpe_sun’” y explore los resultados.

Ahora solo nos queda el dltimo paso, el de conservar ese valor de la mejor correccién para pixeles cercanos a una
estacién pluviométrica y agregar el valor de estimacion satelital en aquellos pixeles que estin lejos de un punto de

control. Con las siguientes lineas llegaremos a los mapas finales de nuestro ejercicio:

cosch:=ifundef(cosch_temp,hydroestimator_025)
cosch_big:=ifundef(cosch_temp_big,hydroestimator_025)

Sus resultados debetfan asemejar a los de la Figura 11.14, dependiendo del filtro usado. Explote los valores de los
pixeles en sus imagenes. Recuerde que puede superponer algunas de ellas para consultar al mismo tiempo los valores
originales y el de las distintas correcciones. Otro buen ejercicio es el de realizar mapas para ver cual de los esquemas

de correccion (ADD o RAT) fue seleccionado en cada pixel y la distribucion espacial de dicha seleccion.
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Figura 11.14 CoSch final, sin filtro (I1zq.) y con el filtro de 3x3 (Der.).

Observe la figura 11.15 que nos muestra una interpolacién pluviométrica y 2 estimaciones satelitales diferentes. Los

{
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campos de precipitacion de las estimaciones satelitales, no son para nada tan homogeneos como los interpolados de
datos de campo. Mientras mayor es el area que usamos para calcular el BIAS, mas errores se incorporan en la
correccion. Esto puede hasta causar precipitaciones negativas, una imposibilidad que hay que tener en cuenta.

Figura 11.15 Comparacion entre interpolacion pluviométrica y estimaciones satelitales.

Calcular estadisticas para cuencas o regiones de interés.

Estos mapas son muy utiles para muchos andlisis pero a veces solo necesitamos valores sobre un area especifica de
nuestro interés (ROI). Ahora es un buen momento para abrir y explorar uno de los mapas suministrados y que se
llama “Cuencas”, también puede vetlo en la figura 11.16.

Note que al explorar este mapa categérico con el botén derecho del ratén presionado, usted vera una etiqueta con el
nombre de la cuenca. Este mapa categdrico serd combinado con nuestra estimacion de precipitacién corregida: el
CoSch. El resultado sera una tabla conteniendo todas las posibles combinaciones de pixeles, sus frecuencias y su

area.

File Edit Layers Options Help

D@k & @ | @ = [1:65739857 |

E-EA B country_ 02

=-E& Properties

éi@m Cuencas - MapSlicing(Cuenca
Properties

Legend

-Amazonas

Orinoco

- Tocantins
- San Francisco

3
[o776 [ 9709'225"5, 71°15'00.00"W | 9°09'22.50°S, 71°1500.00'W /|

Figura 11.16 Mapa de clases de ILWIS con las cuencas mas grandes de Sudamérica.

Desde el menu principal de ILWIS, seleccione: “Operations” > “Raster Operations” > Cross”, complete con los detalles

provistos en la figura 11.17 y presione “Show”. O Bien pude escribir lo siguiente en la linea de comando principal:

Rain_basin_cross.tbt:=TableCross(Cuencas, cosch,IgnoreUndefs)

1st Map I Efh Cuencas
v lgnore Undefs

2nd Map I Effcosch
v lgnore Undefs

Output Table |F|ain_hasin_c:ross

Description:

[ Qutput Map

Show Define Cancel




Figura 11.17 Detalle del cruzamiento
Abra la tabla “rain_basin_cross” e inspeccione su contenido
Una columna que nos va a ser muy util mas adelante es la que valores de precipitaciones >=1, esta es una manera
habitual de eliminar pixeles residuales y obtener un area de precipitacion mas exacta. La funcién “iff” puede ser usada
en ILWIS dentro del contexto de tablas, asi que vamos a crear una nueva columna “cosch_GE_1mn?’, introduciendo
esta linea en la linea de comando de la TABLA (y no en la linea principal de ILWIS):
cosch_GE_1mm:=iff(cosch ge 1,cosch,?)
Ahora vamos a realizar el calculo de la precipitacién media areal para cada cuenca. Para ello vamos a crear una nueva
tabla “statistics”. Desde el menu de Tabla seleccione “Columns” > “Aggregation”, y complete los campos usando de
referencia la figura 11.18, no olvide presionar “OK”.
Figura 11.18 Cilculo de estadisticas sobre las lluvias agregadas por cuencas
Explore la tabla resultante “statistics” y los valores de la media que se obtuvieron. Recuerden que para una mejor

estimacion del drea de la tormenta es mejor usar la media pero de pixeles >= 1mm. Ahora vamos a hacer estos

calculos desde la linea de comando principal de ILWIS, as{ que cierre ambas tablas.
Para calcular la precipitacién media areal >=1 pruebe escribir la siguiente linea:
tabcalc statistics cosch_ge_1mm:=ColumnJoinAvg(Rain_basin_cross.tbt,cosch_GE_1 mm, Cuencas,NPix)
Otro dato interesante es saber cual fue la precipitaciéon maxima:
tabcalc statistics maximum:=ColumnJoinMax(Rain_basin_cross.tbt,cosch, Cuencas,1)
Finalmente podemos obtener el area de la cuenca normalizada en que la precipitacién es >=1:
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tabcalc rain_basin_cross.tbt NPix_ GE_1mm:=iff(cosch ge 1,NPix,0)
crtbl Tabla_temp cuencas

tabcalc Tabla_temp sum_NPix:=ColumnJoinSum(Rain_basin_cross.tbt,NPix,Cuencas, 1)



tabcalc Tabla_temp sum_NPix_GE_1mm:=ColumnJoinSum(Rain_basin_cross.tbt,
NPix_GE_1mm,Cuencas,1)

tabcalc statistics area_ GE_1mm:=Tabla_temp.tbt.sum_NPix_GE_1mm *100 / Tabla_temp.tbt.sum_NPix
No hemos derivado édreas en ha o km2 ya que los mapas no estan proyectados, pero a los fines de ejercitacion la
proporcion de la cuenca es suficiente. Si usted conoce el area de su ROI, facilmente puede obtener el area utilizando

esta proporcion.

Felicitaciones!! Su tabla final deberfa parecerse a la mostrada en la figura 11.19. También puede es interesante

observar el contenido de la “Tabla_temp”.
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Figura 11.19 Estadisticas finales sobre las cuencas principales de Sudamérica.

Como ultima tarea observe el contenido del script de ILWIS llamado “serjpz_anto_media”. Este le permite correr todo
el gjercicio de manera automatica “;-p” asi que puede usarlo tanto para aprender a hacer sctipt como para copiat

procesos de este ¢jetcicio que le interese automatizar o replicat.

Conclusion

La metodologia ensefiada en este ejercicio se aplica satisfactoriamente a la Cuenca del Rio de la Plata para mejorar su
manejo. Si bien se utilizan otras fuentes de datos con mayor resolucién, el mecanismo es el mismo y puede replicarse
en cualquier otro lugar. En este caso fue adaptado para utilizar productos gratuitos que son provistos por DevCoCast
y el NOAA-CPC de manera libre. Por lo que hace falta un estudio mas detallado para estimar su precision y sus
limitaciones con estos sets de datos. Siempre hay que tener en cuenta que la precision, exactitud y el impacto de la
cotrreccion van a estar intimamente asociados a la densidad de estaciones pluviométricas, el régimen y el tipo de
precipitaciones dominantes y el tamafio de las Regiones de Interés. Por lo que hace investigar este caso patticular a

fin de saber cuil es su confiabilidad.

Por lo pronto, la aplicacién de esquema de correccion combinado CoSch, utilizando otras estimaciones satelitales y

datos pluviométricos, es bastante sencilla utilizando esta metodologfa en un software libre como ILWIS.
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